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Chapter 831

Tolerance Intervals for
Any Data
(Nonparametric)
Introduction
This routine calculates the sample size needed to obtain a specified coverage of a β-content tolerance interval at a
stated confidence level for data without a specified distribution. These intervals are constructed so that they
contain at least 100β% of the population with probability of at least 100(1 - α)%. For example, in water
management, a drinking water standard might be that one is 95% confident that certain chemical concentrations
are not exceeded more than 3% of the time.

Difference between a Confidence Interval and a Tolerance Interval
It is easy to get confused about the difference between a confidence interval and a tolerance interval. Just
remember than a confidence interval is usually a probability statement about the value of a distributional
parameter such as the mean or proportion. On the other hand, a tolerance interval is a probability statement about
a proportion of the distribution from which the sample is drawn.

Technical Details
This procedure is primarily based on results in Guenther (1977) and Hahn and Meeker (1991).
A tolerance interval is constructed from a random sample so that a specified proportion of the population is
contained within the interval. The interval is defined by two limits, L1 and L2, which are constructed using order
statistics
𝐿𝐿1 = 𝑋𝑋(𝑖𝑖) , 𝐿𝐿2 = 𝑋𝑋(𝑗𝑗)

where X(i) is the ith order statistic found by sorting the data in ascending order and selecting the ith sorted value.

Proportion of the Population Covered
An important concept is that of coverage. Coverage is the proportion of the population distribution that is between
the two limits. In the nonparametric case, these population limits are defined by quantiles of the distribution.
The coverage is the area under the (unknown) distribution between these limits.
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Solving for N
The tolerance limits are found by selecting the appropriate order statistics: X(i) and X(j) so that
Pr�𝑋𝑋(𝑗𝑗) −𝑋𝑋(𝑖𝑖) ≥ 𝑃𝑃� = 1 − 𝛼𝛼

Guenther (1977) provides the following two inequalities that can be solved simultaneously for i, j, and minimum
N in the two-sided case.
𝐸𝐸(𝑁𝑁 − 𝑗𝑗 + 𝑖𝑖 + 1; 𝑁𝑁, 1 − 𝑃𝑃) ≥ 1 − 𝛼𝛼

𝐸𝐸(𝑁𝑁 − 𝑗𝑗 + 𝑖𝑖 + 1; 𝑁𝑁, 1 − 𝑃𝑃 − 𝛿𝛿) ≤ 𝛼𝛼′

where

𝑛𝑛

𝑛𝑛

𝑥𝑥=𝑟𝑟

𝑥𝑥=𝑟𝑟

𝑛𝑛
𝐸𝐸(𝑟𝑟; 𝑛𝑛, 𝑝𝑝) = 𝑃𝑃𝑃𝑃(𝑋𝑋 ≥ 𝑟𝑟) = � 𝑏𝑏(𝑥𝑥; 𝑛𝑛, 𝑝𝑝) = � � � 𝑝𝑝 𝑥𝑥 (1 − 𝑝𝑝)𝑛𝑛−𝑥𝑥
𝑥𝑥

It turns out that the solution is for minimum N and for the difference N - j + i + 1. For example, if the solution to a
particular problem turns out to be N = 38 and N - j + i + 1 = 5, then any of the index pairs (1, 35), (2, 36), (3, 37),
and (4, 38) will work. That is, any pair for which j – i = 34. Note that here (2, 36) represents the order statistics:
X(2) and X(36).
In this example, any of the four pairs are solutions to the two inequalities. Usually, a reasonable choice is to pick
one of the central pairs. In the program, we arbitrarily pick (2, 36). But remember that this choice is not unique.
The solution is found using a smart searching algorithm that we developed for the one-proportion test which
solves a similar problem.

Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains most of the parameters and options that you will be concerned with.

Solve For
Solve For
Select the parameter you want to solve for. The parameter you select here will be shown on the vertical axis in the
plots.
Sample Size N
A search is conducted for the minimum sample size that adheres to the parameter values. Remember that the
search is based on two inequalities, so the particular values of the confidence level and alpha' may not be met
exactly.
Exceedance Margin δ
A search is conducted for the value of δ that meets the requirements of the confidence level and alpha'
inequalities.
α' = Pr(p ≥ P + δ)
α' is the probability that the sample coverage is ≥ P + δ. A search is conducted for the value of α' that meets the
requirements of the other settings.
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Coverage Probabilities Calculation Method
Method
Select the method to be used to calculate the coverage probabilities. When the sample sizes are reasonably large
(i.e. greater than 100) and the coverage proportions are between 0.2 and 0.8, the two methods will give similar
results. For smaller sample sizes and more extreme proportions (less than 0.2 or greater than 0.8), the normal
approximation is not as accurate so binomial enumeration is more appropriate.
The choices are
Binomial Enumeration
Each coverage probability is computed using exact binomial enumeration of all possible outcomes when N ≤ Max
N for Binomial Enumeration (otherwise, the normal approximation is used). Binomial enumeration of all
outcomes is possible because of the discrete nature of the data. This method is a little slower for larger N, but the
answers are exact!
Normal Approximation
Approximate coverage probabilities are computed using the normal approximation to the binomial distribution.
This method is faster, but less accurate.
Max N for Binomial Enumeration (Method = None)
When N is less than or equal to this value, probabilities are calculated using the binomial distribution and
enumeration of all possible outcomes. This is possible because of the discrete nature of the data.
When N is greater than this value, the normal approximation to the binomial is used when calculating
probabilities.
We have found that with the speed of modern computers, this value can be set very large. We have put the default
at 100,000.

One-Sided Limit or Two-Sided Interval
Interval Type
Specify whether the tolerance interval is two-sided or one-sided. A one-sided interval is usually called a tolerance
bound rather than a tolerance interval because it only has one limit.
Two-Sided Tolerance Interval
A two-sided tolerance interval, defined by two limits, will be used.
Upper Tolerance Limit
An upper tolerance bound will be used.
Lower Tolerance Limit
A lower tolerance bound will be used.

Sample Size
N (Sample Size)
Enter one or more values for the sample size. This is the number of individuals selected at random from the
population to be in the study.
You can enter a single value or a range of values.
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Proportion of Population Covered
Proportion Covered (P)
Enter the proportion of the population that is covered by the tolerance interval. This the desired coverage
proportion between the tolerance limits. It is the probability (area) between the tolerance limits based on the
normal distribution. This is the proportion of the population that lies between the two limits.
If a two-sided interval (L1, L2) is specified, this is the desired area of the probability distribution between L1 and
L2. If F(x) is the CDF of the distribution, P = F(L2) - F(L1).
If a lower limit (L1) is specified, this is the desired area of the probability distribution above L1. If F(x) is the
CDF of the distribution, P = 1 - F(L1).
If an upper limit (L2) is specified, this is the desired area of the probability distribution below L2. If F(x) is the
CDF of the distribution, P = F(L2).
The possible range is 0 < P < 1 - δ. Usually, one of the values 0.80, 0.90, 0.95, or 0.99 is used.
You can enter a single value such as 0.9, a series of values such as 0.8 0.9 0.99, or a range such as 0.8 to 0.98 by
0.02.
Confidence Level (1 - α)
Specify the proportion of tolerance intervals (constructed with these parameter settings) that would have the same
coverage. The absolute range is 0 < 1 - α < 1. The typical range is 0.8 < 1 - α < 1.
Usually, one of the values 0.90, 0.95, and 0.99 is used.
You can enter a single value such as 0.95, a series of values such as 0.9 0.95 0.99, or a range such as 0.8 to 0.95
by 0.01.

Proportion Covered Exceedance
Proportion Covered Exceedance Margin (δ)
δ is added to P to set an upper bound of P' = P + δ on the coverage. Hence, δ represents a precision value for P.
The value of P' is set to occur with a low probability (0.05 or 0.01).
For example, if P = 0.9 and δ = 0.01, then the parameters are set so that a coverage of 0.9 occurs with high
probability, but a coverage of 0.91 occurs with low probability.
The possible range is 0 < δ < 1 - P. Usually 0.1, 0.05, or 0.01 is used.
You can enter a single value such as 0.02 or a series of values such as 0.01 0.02 0.05 or a range such as 0.01 to
0.05 by 0.01
α' = Pr(p ≥ P + δ)
α' is the probability that the sample coverage p is greater than P + δ. It is set to a small value such as 0.05 or 0.01.
The range is 0.0 < α' < 0.5. Usually 0.1, 0.05, or 0.01 is used.
You can enter a single value such as 0.05, a series of values such as 0.01 0.02 0.05, or a range of values such as
0.01 to 0.05 by 0.01.
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Example 1 – Calculating Sample Size
Suppose a study is planned to determine the sample size required to compute a two-sided 95% tolerance interval
the covers 90% of the population without making specific assumptions about the data distribution. The researcher
wants to investigate using a δ of 0.01, 0.025, or 0.05 with an α’ of 0.05.
Suppose a study is planned to determine the sample size required to compute a two-sided 95% normal tolerance
interval the covers 90% of the population. The researcher wants to investigate using a δ of 0.01, 0.02, or 0.05 with
an α’ of 0.05.

Setup
This section presents the values of each of the parameters needed to run this example. First load the Tolerance
Intervals for Any Data (Nonparametric) procedure window. You may then make the appropriate entries as
listed below, or open Example 1 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Method .................................................... Binomial Enumeration
Max N for Binomial Enumeration ............ 100000
Interval Type ........................................... Two-Sided Tolerance Interval
Proportion Covered (P) ........................... 0.9
Confidence Level (1 – α) ........................ 0.95
Coverage Proportion Exceedance (δ) .... 0.01 0.025 0.05
α' = Pr(p ≥ P + δ) .................................... 0.05

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for Nonparametric Two-Sided Tolerance Interval

Confidence
Level
1-α
0.950
0.950
0.950

Sample
Size
N
9309
1387
298

Proportion
Covered
P
0.900
0.900
0.900

Proportion
Covered
Exceedance
Margin
δ
0.010
0.025
0.050

P+δ
0.910
0.925
0.950

Pr(p ≥ P + δ)
α'
0.050
0.050
0.050

Two-Sided
Tolerance
Interval
X(441), X(8867)
X(60), X(1327)
X(11), X(288)

References
Guenther, William C. 1972. 'Tolerance Intervals for Univariate Distributions.' Naval Research Logistics
Quarterly, Vol. 19, No. 2, Pages 309-333.
Guenther, William C. 1977. Sampling Inspection in Statistical Quality Control. Griffin’s Statistical
Monographs, Number 37. London.
Hahn, G. J. and Meeker, W.Q. 1991. Statistical Intervals. John Wiley & Sons. New York.
Krishnamoorthy, K. and Mathew, T. 2009. Statistical Tolerance Regions. John Wiley, New York.
Report Definitions
Confidence Level (1 - α) is the proportion of studies with the same settings that produce tolerance intervals with
a proportion covered of at least P.
N is the number of subjects.
Proportion Covered P is the proportion of the population covered. It is the probability between the tolerance
interval limits. It is valid for any distribution.
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Proportion Covered Exceedance Margin δ is the value that is added to P to set an upper bound on the coverage at P +
δ.
P + δ is the upper limit of the proportion covered P. It is a measure of the precision (closeness) of the actual
coverage to P.
α' = Pr(p ≥ P + δ) is the probability that the coverage computed from a random sample (p) is greater than P + δ. It
is set to a small value such as 0.05 or 0.01.
X(i) and X(j) are the ith and jth sample order statistics (i < j). The values within the parentheses are the
indices of the order statistics. For example, X(53) means the 53rd observation after the N values are sorted in
ascending order. These two values form the limits of the tolerance interval.
Summary Statements
A two-sided nonparametric tolerance interval computed from a sample of 9309 observations has a
target coverage of 0.900 at a 0.950 confidence level. The probability that the coverage exceeds
the target value by an amount ≥ 0.010 is 0.050. The order statistics that become the limits of
the tolerance interval are X(441), X(8867).
Dropout-Inflated Sample Size

Dropout Rate
20%
20%
20%

Sample Size
N
9309
1387
298

DropoutInflated
Enrollment
Sample Size
N'
11637
1734
373

Expected
Number of
Dropouts
D
2328
347
75

Definitions
Dropout Rate (DR) is the percentage of subjects (or items) that are expected to be lost at random during the
course of the study and for whom no response data will be collected (i.e. will be treated as "missing").
N is the evaluable sample size at which the tolerance interval is computed. If N subjects are evaluated out of
the N' subjects that are enrolled in the study, the design will achieve the stated tolerance interval.
N' is the total number of subjects that should be enrolled in the study in order to end up with N evaluable
subjects, based on the assumed dropout rate. After solving for N, N' is calculated by inflating N using the
formula N' = N / (1 - DR), with N' always rounded up. (See Julious, S.A. (2010) pages 52-53, or Chow, S.C.,
Shao, J., and Wang, H. (2008) pages 39-40.)
D is the expected number of dropouts. D = N' - N.

This report shows the calculated sample size for each of the scenarios.

Plots Section

This plot shows the sample size versus the three value of δ.
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Example 2 – Calculating α’
Continuing Example 1, the researchers wants to show the impact of various sample sizes on α'. They decide to
determine the value of α' for various value of N between 600 and 2200, keeping the other values the same except
that they set δ to 0.025.

Setup
This section presents the values of each of the parameters needed to run this example. First load the Tolerance
Intervals for Any Data (Nonparametric) procedure window. You may then make the appropriate entries as
listed below, or open Example 2 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ α' = Pr(p ≥ P + δ)
Method .................................................... Binomial Enumeration
Max N for Binomial Enumeration ............ 100000
Interval Type ........................................... Two-Sided Tolerance Interval
N (Sample Size)...................................... 600 to 2200 by 200
Proportion Covered (P) ........................... 0.9
Confidence Level (1 – α) ........................ 0.95
Coverage Proportion Exceedance (δ) .... 0.025

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for Nonparametric Two-Sided Tolerance Interval

Confidence
Level
1-α
0.950
0.950
0.950
0.950
0.950
0.950
0.950
0.950
0.950

Sample
Size
N
600
800
1000
1200
1400
1600
1800
2000
2200

Proportion
Covered
P
0.900
0.900
0.900
0.900
0.900
0.900
0.900
0.900
0.900

Proportion
Covered
Exceedance
Margin
δ
0.025
0.025
0.025
0.025
0.025
0.025
0.025
0.025
0.025

P+δ
0.925
0.925
0.925
0.925
0.925
0.925
0.925
0.925
0.925

Pr(p ≥ P + δ)
α'
0.342
0.228
0.128
0.087
0.049
0.034
0.020
0.011
0.006

Two-Sided
Tolerance
Interval
X(23), X(576)
X(33), X(768)
X(42), X(958)
X(51), X(1149)
X(61), X(1340)
X(69), X(1530)
X(79), X(1721)
X(89), X(1912)
X(98), X(2102)

This report shows the impact on α' of various sample sizes. Since the values of the Tolerance Factor indices are
not related to α' or δ, this report allows you to calculate appropriate indices for use with sample data.
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Plots Section

This plot shows the sample size versus α'.
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Example 3 – Validation using Guenther (1977)
Guenther (1977) page 161 gives an example in which P = 0.8, 1 – α= 0.9, P + δ = 0.95, and α’ = 0.05. He obtains
a sample size of 38 with lower limit X(2) and upper limit X(36).

Setup
This section presents the values of each of the parameters needed to run this example. First load the Tolerance
Intervals for Any Data (Nonparametric) procedure window. You may then make the appropriate entries as
listed below, or open Example 3 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Method .................................................... Binomial Enumeration
Max N for Binomial Enumeration ............ 100000
Interval Type ........................................... Two-Sided Tolerance Interval
Proportion Covered (P) ........................... 0.8
Confidence Level (1 – α) ........................ 0.9
Coverage Proportion Exceedance (δ) .... 0.15
α' = Pr(p ≥ P + δ) .................................... 0.05

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for Nonparametric Two-Sided Tolerance Interval

Confidence
Level
1-α
0.900

Sample
Size
N
38

Proportion
Covered
P
0.800

Proportion
Covered
Exceedance
Margin
δ
0.150

P+δ
0.950

Pr(p ≥ P + δ)
α'
0.050

Two-Sided
Tolerance
Interval
X(2), X(36)

PASS also calculates a sample size of 38. The values of X(i) and X(j) match as well.
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